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About this document 

Scope and purpose 

This user guide provides an overview of the reference board REF-SHA35WRC2SYS including its main features, 
key test results and mechanical dimensions. 

The REF-SHA35WRC2SYS is a full-featured starter kit, with a turnkey motor driver designed for high-performance, 

high-efficiency permanent magnet synchronous motor (PMSM) / brushless direct current motor (BLDC) 

applications, including all of the required elements for high voltage ceiling fan applications. It includes the 
iMOTIONTM IMD112T driver for PFC and motor control, the 1ED44171N01B for PFC gate driver, IKA08N65H5 

DuoPack IGBTs and diodes for PFC switching, and the TRENCHSTOPTM RC-Series IKN03N60RC2 that provides 
cost-effective, monolithically integrated IGBTs with diode for the inverter stage. 

The starter kit features Infineon’s iMOTIONTM driver and advanced motion control engine (MCE 2.0) technology 
for PMSM/BLDC motor and PFC driver. It is optimized for small and major home appliances like fans, pumps, 

compressors and other general-purpose variable speed drives. 

Note: Please note that this product is not qualified according to the AEC Q100 or AEC Q101 documents 

from the Automotive Electronics Council. 

Intended audience 

This user guide is intended for all technical specialists who are familiar with ceiling fan control and electronics 

converters. The reference design is intended to be used under laboratory conditions only by trained specialists. 

Reference board/kit 

Product(s) embedded on a PCB, with a focus on specific applications and defined use cases that may include 
software. PCB and auxiliary circuits are optimized for the requirements of the target application. 

Note: The boards do not necessarily meet the safety or quality standards requirements such as UL, CE. 
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Important notice 

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board 

(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration, 
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).  

 
Environmental conditions have been considered in the design of the Evaluation Boards and Reference 
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards 
has been tested by Infineon Technologies only as described in this document. The design is not qualified 

in terms of safety requirements, manufacturing and operation over the entire operating temperature 

range or lifetime. 
 
The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional 

testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the 

same procedures as regular products regarding returned material analysis (RMA), process change 
notification (PCN) and product discontinuation (PD). 
 

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for 

evaluation and testing purposes. In particular, they shall not be used for reliability testing or production. 
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards 

(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other 
requirements of the country in which they are operated by the customer. The customer shall ensure that 

all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant 

requirements and standards of the country in which they are operated. 
 

The Evaluation Boards and Reference Boards as well as the information provided in this document are 

addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and 

managed according to the terms and conditions set forth in this document and in other related 

documentation supplied with the respective Evaluation Board or Reference Board.  
 
It is the responsibility of the customer’s technical departments to evaluate the suitability of the 

Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness 

and correctness of the information provided in this document with respect to such application. 

 
The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not 
cause any harm to persons or third party property.  

The Evaluation Boards and Reference Boards and any information in this document is provided "as is" 
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to 

warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or 
for merchantability.  

 
Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation 
Boards and Reference Boards and/or from any information provided in this document. The customer is 

obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or 
damages arising out of or resulting from any use thereof. 

 
Infineon Technologies reserves the right to modify this document and/or any information provided 
herein at any time without further notice. 
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Safety precautions 

Note: Please note the following warnings regarding the hazards associated with development systems. 

Table 1 Safety precautions 

 

Warning: The DC link potential of this board is up to 1000 VDC. When measuring 
voltage waveforms by oscilloscope, high voltage differential probes must be used. 

Failure to do so may result in personal injury or death. 

 

Warning: The evaluation or reference board contains DC bus capacitors which take 
time to discharge after removal of the main supply. Before working on the drive 
system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to 

do so may result in personal injury or death. Darkened display LEDs are not an 

indication that capacitors have discharged to safe voltage levels. 

 

Warning: The evaluation or reference board is connected to the grid input during 
testing. Hence, high-voltage differential probes must be used when measuring voltage 

waveforms by oscilloscope. Failure to do so may result in personal injury or death. 

Darkened display LEDs are not an indication that capacitors have discharged to safe 

voltage levels. 

 

Warning: Remove or disconnect power from the drive before you disconnect or 
reconnect wires, or perform maintenance work. Wait five minutes after removing 

power to discharge the bus capacitors. Do not attempt to service the drive until the bus 
capacitors have discharged to zero. Failure to do so may result in personal injury or 

death. 

 

Caution: The heat sink and device surfaces of the evaluation or reference board may 

become hot during testing. Hence, necessary precautions are required while handling 

the board. Failure to comply may cause injury. 

 

Caution: Only personnel familiar with the drive, power electronics and associated 
machinery should plan, install, commission and subsequently service the system. 

Failure to comply may result in personal injury and/or equipment damage. 

 

Caution: The evaluation or reference board contains parts and assemblies sensitive to 

electrostatic discharge (ESD). Electrostatic control precautions are required when 

installing, testing, servicing or repairing the assembly. Component damage may result 
if ESD control procedures are not followed. If you are not familiar with electrostatic 

control procedures, refer to the applicable ESD protection handbooks and guidelines. 

 

Caution: A drive that is incorrectly applied or installed can lead to component damage 

or reduction in product lifetime. Wiring or application errors such as undersizing the 
motor, supplying an incorrect or inadequate AC supply, or excessive ambient 

temperatures may result in system malfunction. 

 

Caution: The evaluation or reference board is shipped with packing materials that 
need to be removed prior to installation. Failure to remove all packing materials that 
are unnecessary for system installation may result in overheating or abnormal 

operating conditions. 
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The board at a glance 

1 The board at a glance 

The REF-SHA35WRC2SYS is a part of Infineon’s TRENCHSTOPTM IGBT, gate driver and iMOTIONTM driver 

reference design kits. It is designed to provide a ready-to-use ceiling fan solution based on the above-
mentioned technology as well as on the advanced motion control engine (MCE 2.0). 

The REF-SHA35WRC2SYS is an optimized design for 35 W high voltage ceiling fan applications. It allows fast 
prototyping and a fast time to market. It is available through regular Infineon distribution partners as well as on 
Infineon's website. The main features of this board are described in Chapter 1.3 of this document. The 
remaining sections provide information for customers, enabling them to copy and modify the design for 

production according to their specific requirements. 

Environmental conditions have been considered in the design of the REF-SHA35WRC2SYS. The design was 

tested as described in this document, but not qualified in terms of safety requirements or manufacturing and 
operation over the whole operating temperature range or lifetime. The boards provided by Infineon are subject 
to functional testing only.  

The boards are not subject to the same procedures as regular products in terms of returned material analysis 
(RMA), process change notification (PCN) and product discontinuation (PD). 

1.1 Delivery content 

The scope of delivery contains the main board REF-SHA35WRC2SYS and daughter board XMC1100_IR_RC as 
shown in Figure 2 to Figure 5, one connecting cable, and remote infrared control box. The detailed ordering 
information is indicated in Table 2. 

Table 2 Delivery content 

  

Base part number Package Standard pack Orderable part number 

Form Quantity 

REF-SHA35WRC2SYS  Boxed 1 

REFSHA35WRC2SYSTOBO1 
XMC1100_IR_RC  Boxed 1 

Cable  Boxed 1 

Remote infrared control box  Boxed 1 
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1.2 Block diagram 

The block diagram of the REF-SHA35WRC2SYS is depicted in Figure 1. 
 

 

Figure 1 Block diagram of the REF-SHA35WRC2SYS 

Figure 2 to Figure 5 depict the functional groups of the main board REF-SHA35WRC2SYS and daughter board 

XMC1100_IR_RC. 
 

 

Figure 2 Functional groups on top side of the main board REF-SHA35WRC2SYS 

1. AC power input connector L, N and PE 

2. Surge, EMI and soft start circuit 
3. PFC inductor and IGBT IKA08N65H5 

4. Auxiliary power supply 
5. iMOTIONTM link connector (J1) 

6. Infrared daughter board connector (J2) 

7. Ceiling fan motor connector (J3) 
8. DC bus capacitor 

 

1 

2 

3 
4

 

5
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7

 

8
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Figure 3 Functional groups on bottom side of the main board REF-SHA35WRC2SYS 

 

Figure 4 Functional groups on top side of the daughter board XMC1100_IR_RC 

 

Figure 5 Functional groups on bottom side of the daughter board XMC1100_IR_RC  

1. IGBT IKN03N60RC2 (mounted per 

default) or IKD04N60RC2 

2. iMOTIONTM driver IMD112T-6F040 
3. Auxiliary power supply 
4. Rectifier 

5. PFC Gate Driver 1ED44171N01B 

1 

3 

4 

2 

1 

1. Infrared signal receiver 

1. XMC1100-Q024F0064 

2. XMC1100-Q024F0064 programming connector (J2) 
3. Main board REF-SHA35WRC2SYS connector (J1) 

1 

2 

3 

5 
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1.3 Main features 

The REF-SHA35WRC2SYS board is an optimized reference design for 230 Vrms ceiling fan applications. It contains 
iMOTION™ driver IMD112T for controller and inverter driver, TRENCHSTOPTM RC-Series cost-effective, 

monolithically integrated IGBT with diode IKN03N60RC2 for inverter switches, 650 V DuoPack IGBT and diode 
IKA08N65H5 for PFC switch, and 1ED44171N01B for PFC gate driver. 

Major REF- SHA35WRC2SYS characteristics include: 

• Infrared remote interface for ceiling fan speed control 

• Last-used setting speed command restore function after re-power 

• DC bus tracking input voltage in PFC control 

• Input voltage range 120~300 Vrms, Normal input voltage 230 Vrms, DC-bus voltage of up to 450V 

• Maximum input power 35 W at Tvj=25°C with input voltage range of 120~300 Vrms 

• PFC factor ≥ 0.9 at normal input voltage 230 Vrms and maximum input power of 35 W 

• iTHD ≤ 10% at normal input voltage 230 Vrms and maximum input power of 35 W 

• Surge compliant with IEC standards IEC61000-4-5, L-N, L-PE and N-PE 4 kV 

• 650 V DuoPack IGBT and diode for PFC switch 

• Single-channel, low-side IGBT gate driver IC for PFC switch driver 

• On-board 0.3 A, 10 mH PFC inductor for 60 kHz PFC operation 

• Cost-effective, monolithically integrated 600 V Reverse Conducting Driver 2 for 16 kHz PWM motor control 

• iMOTIONTMdriver for PFC and motor control 

• Overcurrent  protection 

• Auxiliary power supply with 14 V 

• 5 V supply by on-board iMOTIONTM driver 

• Main board PCB with 90 mm diameter cycle, single layer, 1 oz. copper 

• Daughter board with 15 mm x 9 mm, 2 layers, 1 oz. copper 

• RoHS compliant 
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1.4 Board parameters and technical data 

Table 3 depicts the key specifications of the reference design of REF-SHA35WRC2SYS. 

Table 3 REF-SHA35WRC2SYS board specifications 

Parameter Symbol Conditions Value Unit 

Input voltage Vac Optimized design for 230 Vrms applications  120 ~ 300 Vrms 

Maximum input current  Iac(max) Input 120 Vrms, input power = 35W, Ta=25C,  

Motor fPWM= 16 kHz, PFC fPWM=60 kHz  

natural cooling mode 

290 mArms 

Normal input current Iac(norm) Input 230 Vrms, input power = 35W, Ta=25C, 

Motor fPWM= 16 kHz, PFC fPWM=60 kHz  

natural cooling mode 

155 mArms 

Maximum input power Pin(max) Input 120 ~ 300Vrms, input power = 35W, Ta=25C, 

natural cooling mode 

35 W 

Maximum motor 

current  

Imtr(max) Input 230 Vrms, input power = 35W, Ta=25C, 

Motor fPWM= 16 kHz, PFC fPWM=60 kHz,  

Natural cooling mode 

130 mArms 

DC bus voltage 

Maximum DC bus 

voltage 

Vdc(max)  DC bus capacitors are 450 V, 22 µF 450 V 

Minimum DC bus 

voltage 

Vdc(min) Aux power supply brown-in voltage  25 V 

Current feedback 

PFC shunt resistance RS1 Direct AD sample, two 0.25 W, 2Ω shunt resistor 

paralleled 

1 Ω 

Motor shunt resistance RS2 Direct AD sample, two 0.25 W, 2Ω shunt resistor 

paralleled 

1 Ω 

Protections 

PFC current protection 

trigger level 

PFCItrip IMD112T’s internal comparator for cycle-by-cycle 

OCP, trip level can be adjusted by R15 & R16 

853 1 mApeak 

Motor current 

protection trigger level 

MtrItrip Wizard setup for OC trigger level, related to AD 

range, shunt resistor RS3, RS4 and pull-up bias  

500 2 mApeak 

Auxiliary power supply1 – 14V 

Output voltage VAUout1 Used for IPM driver 14 ± 2% V 

Maximum output 

current 

IAUout1  175 mA 

                                                                    
1     For iMOTION™ IC IMD112T PFC overcurrent protection, there are two options in the MCEWizard setup.  

If you select “Cycle-By-Cycle” mode, the PWM output immediately goes to logic LOW when the inductor current exceeds the pre-

determined OCP threshold, and re-starts at the following PWM cycle.  

 If you select “Latch-off” mode, PFC state machine would shift from RUN state to FAULT state when the inductor current exceeds the 

pre-determined OCP threshold for a duration specified by parameter “PFC_GateKillTime”, only Fault_clear command can make it 

back to STOP/RUN mode. 
2     For iMOTION™ IC IMD112T, there is only one type of Gatekill input source in MCEWizard setup: comparator. The feedback current will 

be compared by the internal comparator with the “Overcurrent Trip Level for Internal GateKill Comparator” value set in MCEWizard. 
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Parameter Symbol Conditions Value Unit 

Auxiliary power supply2 – 5V 

Output voltage VAUout2 Supplied by IMD112T and power daughter board 5 ± 4% V 

Maximum output 

current 

IAUout2  10 mA 

PCB characteristics 

Main board dimension  Diameter× height, single layer 90×65 mm 

Material  FR4, 1.6 mm thickness, 1 oz.  PCB   

Daughter board 

dimension 

 Length × width × height, double layer 19×15 

×11 

mm 

Material  FR4, 1.6 mm thickness, 1 oz.  PCB   

System environment 

Ambient temperature Ta Non-condensing, maximum RH of 95% 0 ~ 50 °C 
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2 System and functional description 

2.1 Commissioning 
 

This section describes how to get the system working after the user has installed the board. The following items 

detail these steps. For those who are familiar with the system, or who have already run the board, some of the 
steps can be skipped, depending on the user’s situation. For more in-depth start-up requirements, please refer 

to the MCE reference manual or the corresponding reference material[4][5][6]. 

2.1.1 Hardware connection 

Figure 6 shows the hardware connection details for the reference design board. 

The iMOTIONTM link cable is needed to bridge the PC/debugger side and motor drive system (the target 

iMOTION™ device, hot side) with 1 kV DC galvanic isolation. Users can go to Section 5.3 for more information on 

the iMOTIONTM
 link. 

1. Connect iMOTIONTM link’s 8-pin cable to main board J1 using the default pin order (only pin 5~8 are used), 

and connect PC and iMOTIONTM link with the USB wire. 

2. Then connect AC power supply (L, N, PE) and the motor (J3). 

3. Connect main board J2 to daughter board J1 by cable attached in package box. 

 

Figure 6 Hardware connection details 

Note: The iMOTIONTM
 link shown in Figure 6 is required for commissioning, but it is not included in the 

delivery content. It can be ordered separately according to the details in Section 5.3. 

AC

https://www.infineon.com/cms/en/product/evaluation-boards/imotion-link/
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2.1.2 Software tools preparation 

The iMOTION™ software tools, MCEDesigner and MCEWizard, are required to set up the system, as well as to 
control and fine-tune the system performance to match users' needs. These tools are available for download 

via the Infineon website (http://www.infineon.com/imotion-software). Please check this page periodically for 
software tools updates. Regarding the use of MCEDesigner and MCEWizard, please refer to the “MCEDesigner 
Application Guide” and the “MCEWizard User Guide,” which can be got in the installing path of each tools. 

Note: This reference board has been tested by the software tools MCEdesigner v2.3.1 and MCEWizard 

v2.3.1. The same performance is not guaranteed for updated software tools. 

2.1.3 Firmware preparation 

Please download MCE firmware via the Infineon website (http://www.infineon.com/imotion-software). Select 

the firmware package “IMD112T-F040 MCE Software Package v x.x.x.” and please check this page periodically 
for MCE firmware updates. The key files included in the package for IMD112T-F040 commissioning are shown 

below. 

a) Firmware (‘.ldf’) 

b) Default parameters (‘.txt’) 

c) Default map file (‘.map’) 

d) MCEDesigner file(‘.irc’). 

Note: This reference board has been tested by MCE firmware IMD112T-F040 MCE Software Package 

v1.3.3. The same performance is not guaranteed for updated software tools and MCE firmware. 

Note: This reference bord has been programmed firmware IMD112T-F040_A_V1.03.03.ldf before 

shipment, so you can re-progarmmed firmware or not. 

2.1.4 Parameter and script files preparation 

 

Figure 7 Wizard welcome page 

http://www.infineon.com/imotion-software
http://www.infineon.com/imotion-software
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If you are not familiar with the application of  iMOTIONTM, you can log-in to myInfineon and make product 
registration, then download the default software package for this reference board. The package includes only 

one MCEWizard file (‘.mc2’) in which all the parameters related to the board hardware and script code for 
remote infrared control have been already configured. To make things easier and save time, you only need to 

modify the parameters related to your motor, and generate the parameters as the steps described below. 

1. Use MCEWizard to open the MCEWizard file (‘.mc2’) as shown in Figure 7, then enter the target motor’s 
system parameters in “Advanced Mode > Motor 1” as shown in Figure 8, which will be used to calculate the 
controller’s digital parameter set, representing the complete motor drive system. 

 

Figure 8 Motor parameters input 

2. To perfect motor running performance, the key motor control parameters listed in Table 4 may need to be 

modified in your commissioning process. 

Table 4 Key parameters for perfecting motor running performance 

Name of item in MCEWizard Description1 

Open loop speed ramp rate Influence motor start up performance. 

Parking time Influence motor start up performance. 

Low speed threshold Influence motor start up performance. 

Low speed current limit Influence motor start up performance. 

Current regulator bandwidth Influence motor steady-state running performance. 

Speed regulator proportional gain Influence motor steady-state running performance. 

Speed regulator integral gain Influence motor steady-state running performance. 

 

                                                                    
1 Only the influence of each key parameter is briefly described here. For more information of each parameters, please refer to the 

description in MCEWizard. 
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3. If the script function for remote infrared control is needed for commissioning, then please go to step 4. if the 
script function is not needed for motor initial open-loop and closed-loop commissioning, then please go to 

step 5. 

4. The script function is enabled by default in the provided MCEWizard file (‘.mc2’). Click menu “Jump to 
page > Script” and click label “Script Coding”, then you can edit the script code according to the properties 

of motor you used as shown in Figure 13. For more information regarding to script editting, please refer to 
the MCE reference manual[6]. About how to change script to adapt customer motor, please refer to Section 
2.4. Then click menu “Jump to page > Verify & Save Page”, go to “Verify & Save Page” page and click on the 
“Calculate Parameters and Compile Script Code” key to calculate parameters and compile script code. If no 
errors are reported, then save the drive parameters set in your project directory by clicking “Export to 

Designer file (.txt)” as shown in Figure 9. If errors are detected, double-click on the error message 
(highlighted in RED) and adjust the related parameters. The saved drive system parameter file will later be 

used for programming. 

The output files of this step are below: 

Table 5 Files generated by MCEwizard (script-enabled) 

Suffix of file Description 

.map Includes the avriables defined in script code and need to import into MCEDesigner .irc 
file. 

.ldf The code compiled from script code and need to programme. 

.txt The parameters for this board hardware and need to programme. 

 

 

Figure 9 Verify and save page (script-enabled) 

5. Click menu “Jump to page > Option” and disable script function as shown in Figure 10. Then click menu 
“Jump to page > Verify & Save Page”, go to “Verify & Save Page” page and click on the “Calculate 
Parameters” key to calculate parameters. If no errors are reported, then save the drive parameters set in 

your project directory by clicking “Export to Designer file (.txt)” as shown in Figure 11. If errors are detected, 

double-click on the error message (highlighted in RED) and adjust the related parameters. The saved drive 
system parameter file will later be used for programming. 
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The output files of this step are below: 

 

Table 6 Files generated by MCEwizard (script-disabled) 

Suffix of file Description 

.txt The parameters for this board hardware and need to programme. 

 

 

Figure 10 Enable/Disable script function in options page 

 

Figure 11 Verify and save page (script-disabled) 
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If you are familiar with the application of iMOTIONTM, you can open MCEWizard and click menu “File > Create 
System Configuration File” to create a new configuration file for IMD112T as shown in Figure 12. Then select 

“Customized Design For Expert User” and configure as below steps: 

 

Figure 12 New configuration file created for IMD112T 

1. Enter the target motor’s system and operating parameters, as well as the reference board’s hardware 

parameters step by step according to MCEWizard user guide[4]. 

2. If the script function for remote infrared control is needed for commissioning, then please go to step 3. if the 
script function is not needed for motor initial open-loop and closed-loop commissioning, then please go to 

step 4. 

3. Click menu “Jump to page > Option” and enable script function as shown in Figure 10. Copy the script code 
for remote infrared control in the Code Listing 1 to “Script Edit Page > Script Coding” in the MCEWizard as 
shown in Figure 13. For more information regarding to script editting, please refer to the MCE reference 

manual[6]. About how to change script to adapt customer motor, please refer to Section 2.4. Then define 
pulse input pin for remote infrared control as shown in Figure 14, and please define the pin 

“GPIO13/DUTYFREQ/PFCG1” as input for this reference board. Then click menu “Jump to page > Verify & 
Save Page”, go to “Verify & Save Page” page and click on the “Calculate Parameters and Compile Script 
Code” key to calculate parameters and compile script code. If no errors are reported, then save the drive 

parameters set in your project directory by clicking “Export to Designer file (.txt)” as shown in Figure 9. If 

errors are detected, double-click on the error message (highlighted in RED) and adjust the related 

parameters. The saved drive system parameter file will later be used for programming. 

The output files of this step are same as Table 5. 

4. Click menu “Jump to page > Option” and disable script function as shown in Figure 10. Then click menu 

“Jump to page > Verify & Save Page”, go to “Verify & Save Page” page and click on the “Calculate 
Parameters” key to calculate parameters. If no errors are reported, then save the drive parameters set in 
your project directory by clicking “Export to Designer file (.txt)” as shown in Figure 11. If errors are detected, 
double-click on the error message (highlighted in RED) and adjust the related parameters. The saved drive 

system parameter file will later be used for programming. 

The output files of this step are as same as Table 6. 
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Figure 13 Script edit page 

 

Figure 14 Pulse input pin definition for remote infrared control 

2.1.5 Program firmware/parameters/script 

The REF-SHA35WRC2SYS reference design kit is shipped with pre-programmed firmware, parameters and script 
code for remote infrared control, since the functional tests are performed before the shipment. Users need to 

program their parameters, as the users’ ceiling fan motor may be different from the one under test. 

Program the IMD112T-6F040 as follows: 

• Program the firmware of the MCE 

• Program parameter sets for system and motor 

• Program customer script file (optional, depending on whether script function is required) 
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or  

• Program the combined file, which is generated by MCEWizard, and contains all three items above. 
Customer script file is optional depending on whether it isnecessary. The combined file is usually used 
for production, since it only needs to be programmed once.  

The programming process is as follows: 

1. Start the MCEDesigner tool, and open MCEDesigner file (‘.irc’) prepared in Section 2.1.3 by clicking “File” > 
“Open.” 

2. Power the iMOTIONTM control IC with 3.3 V. It is recommended to program the IC with the 3.3 V isolated 

power supply that comes from the iMOTIONTM link; there is a switch on the iMOTIONTM link to enable/disable 
the 3.3 V output. The iMOTIONTM control IC will also be powered by the on-board auxiliary power supply 

after the AC source is powered. Caution must be taken in the latter case due to high voltage. 

Note: The output voltage of LDO combined in the IMD112T-6F040 is 5 V, i.e. the controller of IMD112T-
6F040 is powered by 5 V. However, it is also possible to use the 3.3 V power supply in the iMOTIONTM 

link to power the IMD112T-6F040 (for programmers).  

3. MCEDesigner should automatically connect to the board using the default COM port (indicated by the green 
circle next to “COMx Up” status in the bottom frame of the MCEDesigner GUI) when iMOTIONTM control IC is 

powered. If it cannot establish the connection due to an incorrect COM port, change the COM port by doing 

the following: click on the “System Page” window and then click on “Preferences > Connection > Connect 

using” and choose one of the other available COM ports from the drop-down list. 

4. In case of a blank IC: If the firmware has been erased from the IMD112T-6F040, the following warning 
message will pop up “Target device firmware and parameters file are not programmed! Please program 

firmware and parameters file” as shown in Figure 15. Then you can program the firmware and parameters 
as described in Step 5. If it is not a blank IC, no such message will be indicated. 

 

Figure 15 MCEDesigner warning message 

 

Figure 16 Program the parameters and firmware 

5. Use the following steps to program the firmware and the parameters file to the internal Flash memory of 
iMOTION™ Control IC as follows: click on the system page, click “Tools” > “Programmer” and select 
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“Program Firmware and Parameters,” as shown in Figure 16. Regarding the firmware and parameters file, 
browse and select the ‘.ldf’ and  ‘.txt’ file prepared in Section 2.1.3 and Section 2.1.4. 

 

6. If the script file needs to be programmed in the internal Flash memory of iMOTIONTM Control IC after 
programmed firmware and parameters file, still click on system page, click “Tools” > “Programmer” and 

select “Program Script,” shown as in Figure 17. Regarding the Script file, browse and select the 
‘xxx_Script.ldf’ file prepared in Section 2.1.4. After programming script, please click “File” > “Import Register 

Map” to import script (.map) file into MCEDesigner file (.irc), and save this (.irc) file, otherwise a map error 
will appear. 

 

  

Figure 17 Program the script 

Note: For detailed information on controller programming, refer to AN2018-33 iMOTION™ 2.0 device 

programming, MCEDesigner documentation and MCEWizard documentation. 

2.1.6 Open-loop diagnostic 

Make sure the input power is 230 Vrms, and program only the firmware and parameters file (script function 
disabled) without remote infrared script control. 

Double-click the “VF Diagnostic” function in the window of motor1, and monitor motor current with 
oscilloscope. If the motor current is not sinusoidal, change register TargetSpeed and Vd_Ext in the VF 
Diagnostic sub-function, then double-click “VF Diagnostic” until the oscilloscope shows a steady sinusoidal 

current with an amplitude of 30~50% motor rate current. 

Double-click “Iu & Iv_Slow” in “System page > Monitor Definitions.” The motor current feedback should be very 

clean and sinusoidal, as shown in Figure 18; otherwise please tune “Gating Driver Propagation Delay & Phase 
Shift Window Size” in MCEWizard.  

“VF Diagnostic” sub-function can check whether: 

• The ceiling fan motor is connected correctly 

• The power stage works as expected 

• Current-sensing related parameters are correctly configured 

• The PCB layout and DC bus decoupling have been done correctly 

After “VF Diagnostic” is done, click STOP button (the red traffic light button) or run the “stop motor” 
function to stop the motor. 

Note: Please do not start PFC in this diagnostic process. 
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Figure 18 Trace waveform for Iu & Iv open loop diagnostic 

2.1.7 Closed loop run 

Make sure the input power is 230 Vrms, and only program firmware and parameters file (script function 
disabled) without remote infrared script.control. 

If the VF Diagnostic works correctly, the hardware circuit and signal sampling will work normally, at which point 

you can try to run the ceiling fan motor in a closed-loop mode. Follow the steps as listed below. 

1.  Start the motor by clicking the green traffic light button in the control bar (or double click Start Motor sub-
function in the window of motor1, which is in the group of User Application Function Definitions). The motor 

will run if above step works correctly. 

2. Check the motor spin direction, adjust the connection order of the motor’s winding; the motor spin 

direction must match the normal running direction of the ceiling fan. 

3. Set TargetSpeed to about 50% of maximum speed, start “Iu & Flx_M” trace with “Auto Repeat on Level,” see 
Figure 19. Flx_M is good within the range of 2000~2500 (rated value is 2048), and must be steady and DC-

like.  
 

 

Figure 19 Trace waveform for Iu & Flx-M at 50% speed 

4. If motor closed loop is tuned up, then the PFC can start when the motor is running. Starting the 
“PFC_AbsVac & PFC_Iref” trace with “Auto Repeat on Level” (see Figure 20) will show the PFC performance. 

The default PFC DC bus target value is set in MCEWizard “Target DC Bus Voltage Initialization.” 
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Figure 20 PFC_AbsVac & PFC_Iref 

5. Once the firmware has been programmed, and only a new parameter file has to be programmed, follow the 

same instructions given in Section Figure 14. In this case, the firmware programming is no longer needed, 
and you can select the first option “Program Parameters.” 

Here are some key tips for better motor-performance commissioning: 

• If Flx_M is not steady (swing or oscillation), check the following: motor parameters, speed loop PI 
bandwidth, current loop bandwidth, flux estimator time constant and PLL PI bandwidth (parameters PLLKp 

and PLLKi) and related equipment. 

• If Flx_M is very noisy, check the following: current feedback and Vdc feedback related hardware and 

parameters. 

• If Flx_M does not come close to 2048, “Motor Back EMF Constant (Ke)” needs to be adjusted in MCEWizard. 

• The PFC parameters in the software package downloaded from myInfineon are optimized for the reference 

board. So it is not necessary to change them. 

2.1.8 Infrared control commissioning 

If the open-loop diagnostic and closed loop work correctly, then the infrared control can be tuned. 

1. Connect the J2 of main board to J1 of daughter board by cables, as shown in Figure 6. The daughter board 
can receive remote infrared commands  from the control box. 

2. Program firmware, parameters file (script function enabled), and script file for remote infrared control by 
iMOTION TM

 link. The iMOTION TM
 link can be removed after programming if you do not want to view the MCE 

variables’ wave or value from MCEDeisgner. 

3. The attached remote infrared control box is shown in Figure 6. There are only power, and 1, 2, 3, 4, 5 

buttons. The power button is to enable or disable controller transmitting. If the controller transmitting is 

enablbed, you can select incrementally different motor speeds with button 1, 2, 3, 4, 5. Button 5 refers to 
maximum motor speed. The daughter board can remember the last set speed by the control box before 
power button being disabled or the daughter board power off, so the motor will start at the last-used 

setting speed when power button is enabled or the daughter board power on. 
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2.2 Description of the main board functional blocks 

2.2.1 EMI filter and surge protection 

Figure 21 shows the diagram of the EMI filter and surge protection. The EMI stages consist of two X-capacitors 
of 100 nF and 330 nF respectively, two series Y-capacitors of 3.3 nF and 4.7 nF respectively, and a 22 mH 
common-mode inductor. The surge protection circuit consists of two stages of MOV, RV1 and RV2; their reverse 

break down voltage is 470 V. The conducted electromagnetic interference of this board is shown in Section 4.7. 
 

 

Figure 21 EMI filter and surge protection 

2.2.2 DC bus sensing and MCEWizard configuration 

Figure 22 shows the detail of the DC bus sensing resistor divider stage.  

With the values shown in the figure, the default DC bus-sense voltage results in a range of 0 V to 5 V on the ADC 

input of the microcontroller (MCU), reflecting an input voltage range from 0 V to 505 V.  
 

 

Figure 22 DC bus sensing  

The hardware parameters need to be configured in MCEWizard as shown in Figure 23. 
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Figure 23 DC bus sensing configuration in MCEWizard 

The Vdc-sensing stage features a low-pass-filter time constant that can be calculated as:  

Time constant =  (𝑅22//𝑅21) ∗ 𝐶18 = (1 𝑀Ω//10 𝑘Ω) ∗ 10 𝑛𝐹 =  99 µ𝑠 Eq.  1 

The value of capacitor C18 can be adjusted to improve the Vdc noise rejection ratio. 

2.2.3 Inverter section 

The inverter section is implemented with the latest generation of RC-D2 IGBT in a SOT223 package 

IKN03N60RC2 or in a DPAK package IKD04N60RC2. The default mounted devices are IKN03N60RC2. 600 V RC-D2 
is the successor to the RC-D/DF IGBT. The latest version of the RC-D technology has several improvements 
compared to its older version: better price, lower power losses, and better controllability over the di/dt in order 
to further reduce EMI compared to RC-D/DF. These devices are also robust for high-voltage and high-humidity 

operations. 

Features of IKN03N60RC2 and IKD04N60RC2: 

• Very tight parameter distribution 

• Operating range of 1 to 20 kHz 

• Maximum junction temperature of 175°C 
• Short-circuit capability of 3 µs 
• Best-in-class current versus package size performance 

• Qualified according to JEDEC for target applications 
• Robust design for high-humidity operation 
• Pb-free lead plating; RoHS compliant 
• Complete product spectrum and PSpice Models 

Figure 24 shows the diagram of the inverter and peripheral circuit. 
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Figure 24 The inverter and peripheral circuit 

2.2.4 Motor current sensing and overcurrent protection   

2.2.4.1 Motor current sensing 

The motor current sensing on this board uses only a RC network for operational gain, bias and low-pass filter to 

minimize the cost. No additional operational amplifier is needed. 

With reference to Figure 25, you can derive the following equation by applying the principle of Kirchhoff's 

voltage law, assuming that the MCU analog-to-digital converter (ADC) input port has an infinite impedance.  

𝑉𝐴𝐷𝐶 =
(𝑉𝑐𝑐 − 𝑉𝑠ℎ𝑢𝑛𝑡)

𝑅1 + 𝑅2
∗ 𝑅1 + 𝑉𝑠ℎ𝑢𝑛𝑡    Eq.  2 

The equation can thus be adjusted as shown:  

𝑉𝐴𝐷𝐶 =
𝑅2 ∗ 𝑉𝑠ℎ𝑢𝑛𝑡

𝑅1 + 𝑅2
+

𝑅1 ∗ 𝑉𝑐𝑐

𝑅1 + 𝑅2
 

Eq.  3 

 

Since the impedance of the RC network is much larger than the 𝑅𝑠ℎ𝑢𝑛𝑡, it follows that: 

𝑉𝑠ℎ𝑢𝑛𝑡 = 𝐼𝑠ℎ𝑢𝑛𝑡 ∗ 𝑅𝑠ℎ𝑢𝑛𝑡 Eq.  4 

As a consequence, VADC can then be written as: 

𝑉𝐴𝐷𝐶 =
𝑅2

𝑅1 + 𝑅2
∗ 𝑅𝑠ℎ𝑢𝑛𝑡 ∗ 𝐼𝑠ℎ𝑢𝑛𝑡 +

𝑅1 ∗ 𝑉𝑐𝑐

𝑅1 + 𝑅2
 Eq.  5 

Where  
𝑅1∗𝑉𝑐𝑐

𝑅1+𝑅2
 is the offset, and the gain of the shunt current is  

𝑅2

𝑅1+𝑅2
∗ 𝑅𝑠ℎ𝑢𝑛𝑡. 
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Figure 25 Motor current-sensing topology 

 

 

Figure 26 Motor current-sensing circuit on the board 
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As an example in Figure 26, this board has the following values: R1 = R1= 47 , R2 = R4 = 1 k, Rs = RS3//RS4 = 

1, Vcc = 5 V. By using the formula in Eq.  5, the offset is 224 mV, and the gain is 
𝑅2

𝑅1+𝑅2
∗ 𝑅𝑠ℎ𝑢𝑛𝑡 = 955 mV/A. 

Because the amplitude attenuation of low-pass filter, the gain needs to be amended to 909 mV/A for 
MCEWizard configuration. 

Note the following points concerning motor current sensing: 

• R1 and R4 in Figure 26 determine the ADC operational bias for current sensing, which corresponds to the 

motor regeneration operation range. For applications that do not work with a regenerative braking mode, 
the bias can be as low as possible to reserve enough ADC range for the drive mode, since the current in the 

sense resistance always flows in one direction only. In this example, the offset is 224 mV. 

• Since the gain of the external RC circuit is less than 1, internal signal amplification is required to increase the 

current signal acquired with low shunt resistance values. MCE provides an inner current sampling amplifier 

with *1, *3, *6 and *12 gain selections, which can be configured in the MCEWizard. In this example, the inner 

current sampling amplifier is *6, so the current sampling range is from 224 mV to 833 mV. 

• There is no common mode noise suppression capability without an outer operational amplifier, so the GND 
network of the PCB needs to be designed very carefully, since any voltage difference between IMD112T’s 
ADC ground and shunt resistor ground will be considered as an “input signal,” and will deteriorate the 

control performance or increase audible noise. 

2.2.4.2 Motor overcurrent protection 

The motor overcurrent condition can be detected by IMD112T-6F040 with internal comparator as shown in 

Figure 27.  

 

Figure 27 Motor overcurrent protection topology 

For more details about motor overcurrent protection (OCP) in the IMD112T, please see the chapter about motor 

overcurrent protection in the reference material [6]. 

The internal comparator’s reference level is set by the internal digital-to-analog converter (DAC) so the level 
can be set in the MCEWizard by “Overcurrent Trip Level for Internal Gatekill Comparator” and “Motor1 current 
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input to ADC offset voltage.” The DAC output pin REFU needs to be connected to a capacitor to improve noise 
rejection (e.g. a 100 nF/25 V capacitor is used on the board as shown in Figure 26). 

2.2.5 PFC section 

Figure 28 provides the PFC MOSFET driver and peripheral circuit. 

 

Figure 28 The PFC and peripheral circuit 

• An 1ED44171N01B is used for the PFC MOS drive. C14, R13 & R14 select the PFC  MOSFET switching du/dt; 
trade-off between switching noise and power loss is required. 

• The bypass diode D14 is designed to bypass the surge current during surge voltage input.  

• Two resistors (1% tolerance, 2 Ω, 0.25 W) are used for PFC current sensing.  

• 10 mH 0.3 A inductor is used for PFC. 

• 650 V DuoPack IGBT with diode IKA0N65H5 is used for the PFC switch. IKA0N65H5 belongs to the high- 

speed switching series of the fifth generation, and has best-in-class efficiency in hard switching and 
resonant topologies. 

2.2.6 PFC current sensing and overcurrent protection   

2.2.6.1 PFC current sensing 

The PFC current sensing on this board uses an RC network for operational gain, bias and low-pass filter to 

minimize the cost. No additional operational amplifier is needed. The PFC current-sensing topology is as shown 
in Figure 29. From the point view of the AD converter, the current input scaling value is the product of the 
voltage of PFC shunt resistor and the gain of RC network. 
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Figure 29 PFC current-sensing topology 

As shown in Figure 28, two resistors RS1 and RS2 (paralleled) with 1% tolerance, 2 Ω, and 0.25 W are used for 
the PFC shunt resistor in this reference board. The real AD input voltage can be calculated as below according 

to the principle of Kirchhoff's voltage law: 

𝑉𝐼𝑃𝐹𝐶_ =
𝑅10

𝑅9 + 𝑅10
∗ 𝑅𝑠ℎ,𝑃𝐹𝐶 ∗ 𝐼𝑠ℎ,𝑃𝐹𝐶 +

𝑅9 ∗ 𝑉𝑐𝑐

𝑅9 + 𝑅10
 Eq.  6 

𝑉𝐼𝑃𝐹𝐶_ =
1𝐾𝛺

180𝛺 + 1𝐾𝛺
∗ 1𝛺 ∗ 𝐼𝑠ℎ,𝑃𝐹𝐶 +

180𝛺 ∗ 5𝑉

180𝛺 + 1𝐾𝛺
= 0.847(𝑚𝑉/𝐴) ∗ 𝐼𝑠ℎ,𝑃𝐹𝐶  + 762 𝑚𝑉 

 

So the offset of PFC current sampling is 762 mV, and the gain is 847 mV/A. Because of the amplitude attenuation 

of the low pass filter, the gain needs to be amended to 806 mV/A for MCEWizard configuration. 

Note the following points concerning PFC current sensing: 

• Since the gain of the external RC circuit is less than 1, internal signal amplification is required to increase the 

current signal acquired with low shunt resistance values. MCE provides an inner current sampling amplifier 
with *1, *3, *6 and *12 gain selections, which can be configured in the MCEWizard. In this example, the inner 

current sampling amplifier is *6, so the maximum input PFC current-sampling voltage should range from 0 
mV to 833 mV (5V/6). 

• In this reference board design, the voltage level on the PFC current-sensing resistor is negative with 

reference to ground, so an ADC operational bias is needed, and PFC current-sensing input polarity should 
select “inverting” in MCEWizard.  R9 and R10 in Figure 28 determine the ADC operational bias for current-

sensing; the bias value is 762 mV, so the real AD sampling range for the PFC current-sampling voltage ranges 
from 0 mV to 762 mV. 

• There is no common mode noise suppression capability without an outer operational amplifier, so the GND 

network of the PCB needs to be designed very carefully. Any voltage difference between IMD112T’s ADC 
ground and shunt resistor ground will be considered as an “input signal,” and deteriorate the PFC 

performance and increase harmonic distortion. 

2.2.6.2 PFC overcurrent protection 

The PFC current-sensing signal feedback to IMD112T-6F040 goes via two pins, the IPFC for PFC control, and the 
PFCITRIP for PFC overcurrent protection. The PFC overcurrent condition can be detected by IMD112T-6F040 
with internal comparator as shown in Figure 27. The overcurrent threshold is designed by the voltage value at 

input pin PFCREF. 
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Figure 30 PFC overcurrent protection topology 

For more details about the PFC overcurrent protection (OCP) in the IMD112T, please refer to the relevant 
chapter in the reference material [6]. 

Note the following points concerning PFC overcurrent protection: 

• The PFC overcurrent threshold of this board is designed by R15 and R16, and the threshold value is 
150 𝛺

10 𝐾𝛺+150 𝛺
∗ 5 𝑉 = 73.6 𝑚𝑉 . That means the PFC overcurrent is 

762 𝑚𝑉−73.9 𝑚𝑉

806 𝑚𝑉/𝐴
= 854 𝑚𝐴. 

 

Figure 31 PFC overcurrent threshold design on the board 

• The PFC overcurrent has two available modes: latch-off and cycle-by-cycle. This reference board uses cycle-

by-cycle mode. For more details about the two PFC overcurrent protection mode, please refer to the 
relevant section in the reference material [6]. 
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2.2.7 Interface circuit of IMD112T 
 

 

Figure 32 Interface circuit of IMD112T 

Figure 32 shows the interface circuit of IMD112T： 

• The power of IMD112T is 14 V and 5 V power generated by internal LDO in IMD112T 

• UH, UL, VH, VL, WH, WL provide driver for inverting circuit 

• IFB+COM is the motor current sensing signal 

• IPFC- is the PFC current sensing signal 

• VAC1 and VAC2 are AC input voltage sensing signals for PFC 

• PFCG0 is the PFC driver 

• PFCREF is the threshold input of PFC overcurrent protection 

• VDC is the bus voltage sensing signal 

• LED2 is the indicator light of IMD112T power on 

• IR_Duty is the duty input signal from the daughter board 

• VSP function is only reserved for a wall regulator, and is not enabled in this board 

• RX0 and TX0 are debugging and programing communication channels to MCEDesigner 
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2.2.8 Interface circuit to XMC daughter board 
 

 

Figure 33 Interface circuit to XMC daughter board 

Figure 32 shows the interface circuit to the XMC daughter board. Its function is to power 5 V for the XMC 

daughter board and receive the duty signal translated from the remote infrared control box. 

Note: For the firmware version V1.03.03 of IMD112T, the infrared signal needs to be translated to duty 
signal by the XMC1100 on the XMC daughter board. The IR_Duty signal is the translated duty signal 

from the XMC daughter board. 

Note: The future updated firmware version of IMD112T, will be able to translate the infrared signal, so 

the IR-Duty signal can connect to the infrared receiver directly, and does not need to be translated 

by XMC1100.  
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2.3 Description of the daughter board functional blocks 

This section depicts the XMC daughter board, which receives signals from the remote infrared control box and 
translates them to duty signal to control the motor speed of the ceiling fan. The communication protocol 

between infrared control box and daughter board is the standard NEC protocol. All the signals received are 
decoded in XMC1100 and ouput duty signals. The XMC1100 can store the last output status when it is power off. 
So XMC1100 will output last-used duty signal when it is power on again. 

2.3.1 Circuit of daughter board 

 

Figure 34 Circuit of daughter board 

As shown in Figure 34, the IRM-3640T receives signals from the remote infrared control box, and XMC1100 

translates them to duty signals. The LED1 indicates the width of the output duty and becomes brighter as the 
width narrows. LED2 and LED3 indicate that XMC1100 has received infrared signals, but their logic is contrary. 

LED2 lights up (is normally off) and LED3 goes off (is normally lit up) when the XMC1100 has received infrared 
signal. 

The J2 is for programming XMC1100, which was programmed before shippment. 

Note: The future updated firmware version of IMD112T will be able to translate the infrared signal, so the 
IR-Duty signal can connect to the infrared receiver directly, and does not need to be translated by 
XMC1100. Only the components in the green frame need to be mounted. Remember to mount R7, 

which is not needed in the present application. 

2.3.2 Output duty signals versus infrared control box buttons 

Figure 35 depicts the output duty signals from the remote infrared control box. When the power button is 
disabled, the output signal is at high level and all other buttons are inactive. When the power button is enabled, 
all other buttons on the control box are active. Then you can selelct button 1 ~ 5 for different motor speed. 
Please note that all the duty cycle ouput from daughter board is low level active. 
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Figure 35 Output duty signals versus infrared control box buttons  
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2.4 Description of script code 

The script code is to control motor and PFC start/stop, and motor target speed according to ducty signal from 
daughter board; it also to control PFC bus target value tracking input voltage and bus target value adjusting 

based on motor back-EMF. 

Figure 36 shows the flow chart of script code and Code Listing 1 shows all the source code of script. There are 

two tasks: Script_Task0 and Script_Task1. Script_Task0() executes every 5 ms and Script_Task1() executes 
every 10 ms. Script_Task0() is to get duty signal from the daughter board and output motor target speed value. 
Script_Task1() is to get the MCE fault, motor real speed, to control motor and PFC start/stop and adjust motor 
target speed and PFC target DC bus value online. 

In Script_Task0_Init(), there is only initialization of status flag sVar_MotorStatus.  

In Script_Task0(), the input duty is united to 0 ~ 1000 counts, reprsenting 0.0% ~ 100.0% duty high level width. 
The active duty cycle in script need to be substracted by 1000 counts for input duty is low level active. The input 

duty is limited from 5% to 95%, the motor and PFC will stop if duty signal is over this limitation. The duty 
counts multiplied 16 represent approximate motor target speed, because 16384 counts repesnts max speed set 

in MCEwiard. For the motor tested in this article, the max active motor speed is limited to 14386 counts in 
script. 

In Script_Task1_Init(), all the cotontrol variables are initialed here. The PllKp and PllKi are especially for the 
motor tested in this article. They will impact motor harmonic current. As usually, the dault value of PllKp and 

PllKi are ok, so they don’t have to redefine here for customer motor. The initial value of TargetSpeed and 
PFC_TargetVolt usually need to be tuned based on customer motor for pferfect start performance. 

In Script_Task1(), first, read the fault information of MCE (motor control engine) and PFC. Second, read input 

voltage value and filter it, then generate tracking bus voltage target for PFC with adding 10V. Third, read motor 

real speed absolute vaule. Fouth, enter into state machine control if the reveived motor target speed is bigger 

than 1000 counts and there is no MCE and PFC fault. Especially the maximum and minimum input voltage 

setting in MCEwizard will trigger PFC fault to stop motor and PFC, so the default setting is 115 Vrms for minimum 

input voltage and 305 Vrms maximum input voltage to ensure that the motor and PFC can only work in 120 Vrms 
~300 Vrms range. 

When sVar_MotorStatus = 0, start motor with the initial target speed. 

When sVar_MotorStatus = 1 and real motor speed over 1200 counts, start PFC with the initial bus target voltage. 

When sVar_MotorStatus = 2, first adjust the motor target speed according to the input duty signal. Second, 

adjust the bus target voltage according to the real motor speed (motor back-EMF) and input voltage, and limit 
the max bus target voltage to 3244 counts (400 V). In the bus target voltage process, usually all the coefficients 
need to be tuned based on customer motor, the principle is to ensure that the motor speed can reach the target 

speed, not limited by back-EMF for bus voltage is not enough and the bus target voltage is as lower as possible 
to reduce power loss. 
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Figure 36 Flow chart of script code 
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Code Listing 1 Script code for remote infrared control 

001 #SET SCRIPT_USER_VERSION (1.00)  /*Script version value should be 255.255*/ 

002 #SET SCRIPT_TASK0_EXECUTION_PERIOD    (5)  /*Script execution time for Task0 

in mS, maximum value 65535*/ 

003 #SET SCRIPT_TASK1_EXECUTION_PERIOD    (1)  /*Script execution time for Task1 

in 10mS, maximum value 65535*/ 

004 #SET SCRIPT_START_COMMAND (0x3)  /* Start command, Task0 : Bit0, Task1 : Bit1; 

if bit is set, script executes after init */ 

005 #SET SCRIPT_TASK0_EXECUTION_STEP (10)  /* Script Task0  step, This defines 

number of lines to be executed every 1mS*/ 

006 #SET SCRIPT_TASK1_EXECUTION_STEP (30) /* Script Task1  step, This defines 

number of lines to be executed every 10mS*/ 

007  

008 /*****************************************************************************

***********************/ 

009  

010 int sVar_MotorStatus;   

011 int sVar_RdDuty; 

012 int sVar_RcCmdSpd; 

013  

014 int sVar_AbsFanSpd; 

015 int sVar_MCEErrorCode; 

016 int sVar_PFCErrorCode; 

017 int sVar_VacRMS_Flt; 

018 int sVar_FollowPFCCmd; 

019  

020 int sVar_temp0; 

021 int sVar_temp1; 

022  

023 /* 

024 Read Dutycycle about 10% ~ 90% (total 664us) 

025 Ton is 66us,199us,332us,465us,598us 

026 */ 

027  

028 /*Task0 init function*/ 

029 Script_Task0_init() 

030 { 

031   sVar_MotorStatus = 0;   

032 } 

033  

034 Script_Task1_init() 

035 {   

036    sVar_MotorStatus = 0; 

037    PllKp = 600; 

038    PllKi  = 100; 

039    Vd_Ext=0; 

040    Vq_Ext=0;  

041    AngleSelect =2; 

042    CtrlModeSelect =2; 

043    Command = 0; 

044    PFC_Command = 0; 

045     

046    TargetSpeed= 1600;       //initial motor speed 40 rpm 

047    PFC_TargetVolt = 2400;   //initial PFC target voltage 296V 

048 } 

049  

050 /*****************Task0 script function*******************/ 

051 /***********RC commnad read and deal      5ms run*********/ 

052 Script_Task0()    

053 { 
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Code Listing 1 Script code for remote infrared control 

054   int ControlDutyTemp; 

055 // Read ControlDuty: 100~900cts for 10%~90% dutycycle,update every 10 ms 

056 // Input low level active 

057     ControlDutyTemp = 1000 - ControlDuty; 

058     if(ControlDutyTemp < 0) 

059     { 

060       ControlDutyTemp = 0; 

061     } 

062     if(ControlDutyTemp > 1000) 

063     { 

064       ControlDutyTemp = 1000; 

065     } 

066     sVar_RdDuty = (ControlDutyTemp + 7 * sVar_RdDuty + 4)>>3; //LPF for 1/8 

067  

068     //Stop or Wrong input, keep Stop and fix SpdCmd = 0 

069     if((sVar_RdDuty > 950)||(sVar_RdDuty < 50))  

070     { 

071        sVar_RcCmdSpd = 0; 

072        Command = 0;  

073        PFC_Command = 0; 

074     } 

075     else 

076     { 

077          sVar_RcCmdSpd = sVar_RdDuty * 16; //Transfer Dutycycle to speed count 

078                                            //(10% --> 1600cts)  

079          if(sVar_RcCmdSpd > 14386) 

080          { 

081             sVar_RcCmdSpd = 14386;   //limit motor speed to max speed 360 rpm 

082          } 

083     } 

084 } 

085  

086 /************Task1 script function***************/ 

087 /******************10ms run*********************/ 

088 Script_Task1()  

089 {   

090    /******Read and LPF*******/  

091    //Read MCE and PFC fault 

092    sVar_ErrorCode =  SwFaults;  

093    sVar_PFCErrorCode = PFC_SwFaults; 

094  

095    // LPF for Vac RMS 

096    sVar_VacRMS_Flt = (7*sVar_VacRMS_Flt + PFC_VacRMS + 4)>>3;     

097     

098    //1.414*32= 45.248 // Vacpeak +10V 

099    sVar_FollowPFCCmd = 81 + (sVar_VacRMS_Flt * 45 + 8)>>4;    

100     

101    // LPF for Fan ABS speed feedback 

102    sVar_AbsFanSpd = (7*sVar_AbsFanSpd + abs_MotorSpeed + 4)>>3;  

103     

104 /******Motor and PFC control, (0,1,2 state machine)*********/ 

105    // Stop PWM if CMD is too low or MCE fault 

106    if (( sVar_RcCmdSpd < 1000) || (sVar_MCEErrorCode >0) || 

(sVar_PFCErrorCode >0)) 

107    { 

108         Command=0; 

109         PFC_Command = 0; 

110         sVar_MotorStatus = 0; 

111    } 
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Code Listing 1 Script code for remote infrared control 

112    else   // Start Motor and update Spd & TargetVolt 

113    {   

114            if (sVar_MotorStatus ==0)                 //From STOP to Start 

115            { 

116                    sVar_MotorStatus = 1;            //Motor start  

117                    AngleSelect =2; 

118                    CtrlModeSelect =2; 

119                    TargetSpeed = sVar_RcCmdSpd;     //Normal Run Speed 

120                    Command = 1;                     //Start motor PWM 

121            } 

122  

123           //Start PFC when motor start OK (speed over Minspd) 

124           if((sVar_MotorStatus ==1) && (sVar_AbsFanSpd > 1200)) 

125            { 

126                sVar_MotorStatus = 2;                //Motor started 

127  

128                //PFC start with a very low voltage REF to reduce power loss 

129                PFC_TargetVolt = 2400;   

130  

131                //Start PFC PWM 

132                PFC_Command=1; 

133            } 

134  

135           //Normal PFC and motor run, update PFC and motor speed command 

136           if(sVar_MotorStatus ==2) 

137           { 

138               TargetSpeed = sVar_RcCmdSpd;  

139  

140               //360RPM= 14386-->2877-->354V, 16383/5 = 3276 -->404V DCBUS 

141               sVar_temp0 = sVar_AbsFanSpd/5;  

142  

143              if(sVar_temp0 > sVar_FollowPFCCmd) 

144              { 

145                 //High spd & BEMF, need higher Vdcbus to support motor run 

146                 PFC_TargetVolt =  sVar_temp0;  

147              } 

148              else  //lower Vdcbus as possible to reduce power loss 

149              { 

150                 //Low Spd or high Vac input, Vdc tracking Vac peak +10V 

151                 PFC_TargetVolt =  sVar_FollowPFCCmd;  

152              } 

153  

154              if (PFC_TargetVolt > 3244) //MAX Vdc limit: 400V *8.11 = 3244 cts 

155              { 

156                 PFC_TargetVolt = 3244; 

157              } 

158           } 

159      } 

160 } 

161 /*******End of Script*******/ 
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3 System design 

This section provides the complete details of the schematics, layout and connectors. Please note that the 
schematics, routing and Gerber files are done in Altium® Designer. Users who are interested in the original 
project files or pdf files can visit the website www.infineon.com and log-in to myInfineon and download on the 

board’s web page. 

3.1 Schematics 

The major function blocks are introduced in Section 2.2 and Section 2.3 . Users who are interested in further 
details can download the design files after logging in to the myInfineon account on the board’s web page. 

3.2 Layout 

3.2.1 Main board layout 

The main board is designed in a single layer and has a ring shape, with dimensions of 90 mm (D) × 65 mm (H). 
The main board is manufactured with a copper thickness of 1 oz. (35 µm). 

 

Figure 37 Top assembly print of the main board 

http://www.infineon.com/
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Figure 38 Bottom assembly print of the main board 

 

Figure 39 Top layer of the main board 
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Figure 40 Bottom layer of the main board 

3.2.2 Daughter board layout 

The daughter board is designed in double layers and has a square shape, with dimensions of 19 mm (L) × 15 

mm (W)× 16 mm (H). The daughter board is manufactured with a copper thickness of 1 oz. (35 µm). 

 

Figure 41 Top assembly print of the daughter board 
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Figure 42 Bottom assembly print of the daughter board 

  

Figure 43 Top layer of the daughter board 

 

 

Figure 44 Bottom layer of the daughter board 
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3.3 Bill of material  

The complete bill of material is available on the download section of the Infineon homepage. A log-in is 
required to download this material. 

Table 7 BOM of the most important/critical parts of main board  

S. No. Ref Designator Description Manufacturer Manufacturer P/N 

1 C16 

CAP/ELCO/22 μF/450 
V/20%/Aluminiumelectrolytic/-

25°C to 105°C/5.00 mm C X 0.60 

mm W 13.00 mm Dia X 26.50 

mm H  

Wurth Elektronik 860241478004 

2 CX1 

CAP/FILM/100 nF/10%/MKP 
(Metallized Polypropylene)/-

40°C to 105°C / 10.00 mm C X 
0.60 mm W 13.00 mm L X 7.00 

mm T X 13.50 mm H  

Wurth Elektronik 890324023023 

3 CX2 

CAP/FILM/330 nF/275 

V/10%/MKP (Metallized 
Polypropylene)/-40°C to 
105°C/12.50 mm C X 0.60 mm 

W 15.00 mm L X 8.50 mm T X 

14.50 mm H 

Wurth Elektronik 890324024003 

4 CY1, CY2 

CAP/CERA / 4.7 nF/2.6 

kV/20%/Y5U (EIA)/-40°C to 
125°C/10.00 mm C X 0.55 mm 

W 13.00 mm L X 5.00 mm T X 

17.00 mm H 

Kemet C961U472MZWDBA7317 

5 CY3, CY4 

CAP/CERA/3.3 nF/2.6 
kV/20%/Y5U (EIA)/-40°C to 

125°C/10.00 mm C X 0.55 mm 
W 11.00 mm L X 5.00 mm T X 

15.00 mm H 

Kemet C941U332MZWDBA7317 

6 
D1, D3, D4, 

D14 
General purpose rectifier 

ON 

Semiconductor 
S1M 

7 D2 
1 A, 50 V – 1000 V glass 

passivated rectifier 

Taiwan 

Semiconductor 
1N4007G-K 

8 Q1 

High speed 5 IGBT in 
TRENCHSTOP 5 technology 
copacked with RAPID1 fast and 

soft antiparallel diode 

Infineon 

Technologies 
IKA08N65H5 

9 
Q2, Q3, Q4, Q5, 

Q6, Q7 

Cost effective monolithically 

integrated IGBT with diode 

Infineon 

Technologies 
IKN03N60RC2 

10 
Q2', Q3', Q4', 

Q5', Q6', Q7' * 

TRENCHSTOP RC-Series for 
hard switching applications, 

VCE 600V, IC 4A 

Infineon 

Technologies 
IKD04N60RC2 

11 U1 
Motor controller with 
integrated high-voltage gate 

Infineon 

Technologies 
IMD112T-6F040 
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S. No. Ref Designator Description Manufacturer Manufacturer P/N 

driver, Integrated script engine 

for application control 

customization, thin-film-SOI-
technology with negative 
transient robustness, built-in 

temperature sensor 

12 U2 
Single-channel low-side IGBT 

gate driver IC 

Infineon 

Technologies 
1ED44171N01B 

13 U3 

Lowest component count, 
energy-efficient off-line 
switcher IC, 175 mA MDCM in 

230 Vrms 

Power 

Integrations 
LNK305DG 

* Q2', Q3', Q4', Q5', Q6', Q7' are alternatives of Q2, Q3, Q4, Q5, Q6, Q7, and  Q2, Q3, Q4, Q5, Q6, Q7 are mounted by default. 

Table 8 BOM of the most important/critical parts of daughter board  

S. No. Ref Designator Description Manufacturer Manufacturer P/N 

1 U1 
Remote receiver 
sensor, 40.0 kHz 14m 

Through Hole 

Everlight IRM-3640T 

2 U2 

XMC1000 industrial 
microcontrollers ARM® 

Cortex®-M0 32-bit 

processor core 

Infineon 

Technologies 
XMC1100-Q024F0064 

 

3.4 Connector details 

3.4.1 Main board connectors 

Table 9 X1, X2, X3 AC input connectors 

PIN Label Function 

X1 L AC line input 

X2 N AC neutral input  

X3 EARTH Earth connector  

Table 10 J1- iMOTIONTM link connector 

PIN Label Function 

5 GND Ground 

6 +5 V On board 5 V supply 

7 RXD0 MCEDesigner & firmware download   

8 TXD0 MCEDesigner & firmware download   

Table 11 J2 - Daughter board connector 

PIN Label Function 
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1 IR Duty Duty signal from daughter board 

2 GND Ground 

3 +5 V On board 5 V supply   

4 Reserved Reserved   

3.4.2 Daughter board connectors 

Table 12 J1 – Main board connector 

PIN Label Function 

1 IR Duty Duty signal to main board 

2 GND Ground 

3 +5 V On board 5 V supply   

4 Reserved Reserved   

Table 13 J2 – XMC1100 programming connector 

PIN Label Function 

1 +5 V On board 5 V supply   

2 SWCLK SWCLK pin of serial wire debug (SWD) 

3 SWD SWD pin of serial wire debug (SWD) 

4 GND Ground 
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4 System performance 

4.1 PFC iTHD at rated condition 

PFC performance is tested at a rated input voltage of 230 Vrms and output rated power of ceiling fan motor. 

Table 14 PFC iTHD at rated condition 

Input voltage 

(Vrms) 

Input current (A) PFC DC target (V) Input power(W) Power factor iTHD(%) 

230 0.137 360 33.2~34.0 0.968~0.974 9.33~9.74 

Legend CH1: Iac, CH2: Vac, CH3: Vdc, CH4: IL 

Condition ⚫ Typical PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor 

speed: 360 rpm. 

⚫ PFC control parameters: KpI= 400, KxI=600, KpV= 1500, KxV=30 
 

 

Figure 45 PFC iTHD at rated condition 

4.2 Bus voltage ripple 

The bus voltage ripple test of input voltage is from 120 Vrms to 270 Vrms. The maximum bus voltage is 395 V. 

Table 15 Bus voltage ripple 

Input voltage (Vrms) PFC DC target (V) Ripple voltage (V) (%) 

120 302 8 2.6 

150 305 8 2.6 

230 360 7 1.92 
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270 395 7.5 1.89 

Legend CH1: Iac, CH2: Vac, CH3: Vdc 

Condition ⚫ Typical PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only 

mode, motor speed: 360 rpm. 
 

 

Figure 46 Bus voltage ripple at input voltage: 120 Vrms, 150 Vrms, 230 Vrms, 270 Vrms 

4.3 PFC IGBT Vce dv/dt performance 

Table 16 PFC IGBT Vce dv/dt performance 

Input voltage 
(V) 

Input power 
(W) 

Input current 

(A) 

PFC DC target 

(V) 

Power 

factor 
dv/dt of Vce (V/ns) 

120 34.2 0.283 260 1 
Rising edge: 4.280 
Falling edge: 3.344 

230 33.9 0.154 360 0.974 
Rising edge: 4.306  

Faling edge: 2.897 

Legend CH2:  Vce, CH3: Vge, CH4: Ic 

Condition ⚫ Typical PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor 

speed: 360 rpm. 
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Figure 47 PFC IGBT Vce dv/dt performance at input voltage = 120 V    

 

Figure 48 PFC IGBT Vce dv/dt performance at input voltage = 230 V    
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4.4 PFC thermal performance 

Table 17 PFC thermal performance 

Input 

voltage (V) 

Input 
power 
(W) 

Input 

current (A) 

PFC DC 

target (V) 

Power 

factor 

Component with 

max temperature 
∆T(℃) 

120 34.2 0.283 300 1 PFC IGBT 61.2 

150 33.9 0.146 300 0.947 PFC IGBT 52.8 

230 34.4 0.146 360 0.978 Motor IGBT 61.5 

270 35.7 0.136 394 0.965 Motor IGBT 71.2 

Condition ⚫ PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor speed: 360 

rpm. 

⚫ PFC control parameters: KpI= 400, KxI=600, KpV= 1500, KxV=30. 

 

 

Figure 49 Input voltage = 120 V   

 

Figure 50 Input voltage = 150 V   
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Figure 51 Input voltage = 230 V 

 

Figure 52 Input voltage = 270 V 

4.5 Inverter IGBT dv/dt performance 

IKN03N60RC2 is used here for the inverter IGBT dv/dt performance test. 

Table 18 Inverter IGBT dv/dt performance 

Current position 
Input 
voltage (V) 

Input power 
(W) 

PFC DC target 

(V) 

Power 
factor 

dv/dt (V/ns) 

At positive current 230 34.5 360 0.976 
Rising edge: 0.576  
Falling edge: 1.38 

Near zero current 230 34.5 360 0.976 
Rising edge: 0.514 

Falling edge: 1.518 

At negative current 230 34.5 360 0.976 
Rising edge: 0.36 
Falling edge: 1.325 

Legend CH1: Vge for low side, CH4: Vge for high side ,CH3: phase output current, CH2: Vce for low side 
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Condition ⚫ PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor speed: 360 

rpm. 

⚫ PFC control parameters: KpI= 400, KxI=600, KpV= 1500, KxV=30. 

 

 

 

Figure 53 At positive current   
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Figure 54 Near zero current   

 

 

Figure 55 At negative current 

4.6 Inverter IGBT dead time test 

IKN03N60RC2 is used here for the inverter IGBT dead time test. 

Table 19 Inverter IGBT dead time 

Input voltage 

(V) 

Input power 
(W) 

PFC DC 

target (V) 

Power 
factor 

Tdon+Tr (ns) Tdoff+Tf (ns) Min dead time (ns) 

120 35.8 260 1 84 512 428 

Legend CH1: Vge for Low side, CH2: Vce for low side, CH3: phase output current. 

Condition ⚫ PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor speed: 

360 rpm. 

⚫ PFC control parameters: KpI= 400, KxI=600, KpV= 1500, KxV=30. 



  

User guide 54 of 60 V3.0  

  2022-5-11 

REF-SHA35WRC2SYS user guide 
High voltage ceiling fan reference design 

  

System performance 

 

 

Figure 56 Inverter IGBT dead time 

4.7 Electromagnetic interference (EMI) conducted 

This section shows the conducted EMI of REF-SHA35WRC2SYS. Test limits follow the EN 55032: conducted 
disturbance at the mains ports of class B ITE (information technology equipment). 

Table 20 Limits for conducted disturbance at the mains ports of class B ITE  

Frequency range (MHz) Limits (dB(µV)) 

Quasi-peak Average 

0.15 to 0.5 66 to 56 56 to 46 

0.5 to 5 56 46 

5 to 30 60 50 

Note: 1. The lower limit applies at the transition frequencies 

2. The limit decreases linearly with the logarithm of the frequency in the range 0.15 MHz to 0.50 
MHz 

Table 21 EMI test result 

Condition ⚫ Motor runs at 360 RPM without load 

⚫ L=10 mH, CM =22 mH, X =100 nF(CX1) + 330 nF(CX2), Two stage Y = 3.3 nF(CY3, CY4)+4.7 

nF(CY1, CY2), PFC Rg =330 Ohm, motor Rg = 620 Ohm 
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Figure 57 Standby mode 

 

Figure 58 Motor and PFC run 

Note: The short and strong PE connecting line is very important for reducing conducted disturbance at 
the mains ports of class B ITE 

4.8 Surge immunity test 

This test is compliant with IEC standards: IEC61000-4-5; the specification is L to N 4 kV. 

Add surge pulse from 0.5 kV to 4 kV on L-N. PFC runs normally, and motor runs at 360 RPM without load. 
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Table 22 Surge pulse condition 

Pulse voltage Basic voltage  Connection  Waveform Coupling 

impedance 

ASYNC/ SYNC 

Angle 

Interval times  

/Total times 

0.5 ~ 4 kV 230 Vrms L-N 1.2/50 μs 18 μF ASYNC 60s / 5 times 

SYNC-0° 60s / 5 times 

SYNC-90° 60s / 5 times 

SYNC-180° 60s / 5 times 

SYNC-270° 60s / 5 times 

0.5 ~ 4 kV 230 Vrms L-PE/N-PE 1.2/50 μs 9 μF + 10ohm ASYNC 60s / 5 times 

SYNC-0° 60s / 5 times 

SYNC-90° 60s / 5 times 

SYNC-180° 60s / 5 times 

SYNC-270° 60s / 5 times 
 

1~2 kV motor & PFC work fine, with only slighy disturbance; 2~4 kV surge trigger overvoltage fault; system can 
go back to work after clearing the fault or re-powering on. 

 

4.9 System test with infrared control 

This test connects the main board and daughter board with cables provided, and uses the script code in 

Section 2.4 for remote infrared control as shown in Figure 6. The test result is shown in Table 23. 
 

Table 23 System test result 

Gear Input 
voltage 

(Vrms) 

Motor 

speed 

 (rpm) 

PFC DC target 

(V) 

iTHD(%) Input 

power 

(W) 

Power factor Input 
current 

(mA) 

1 

120 

39 168 56.5% 1.8 0.811 21.7 

2 119 168 24.3% 3.5 0.924 33.1 

3 199 196 9.12% 8.7 0.961 77.4 

4 279 275 5.18% 19.7 0.989 164.7 

5 360 350 6.37% 36.5 0.998 298 

1 

150 

39 211 70.8% 2.1 0.731 25.54 

2 119 211 34.6% 3.8 0.897 32.55 

3 199 209 17.40% 8.5 0.943 63.67 

4 279 275 5.63% 19 0.981 128.2 

5 360 354 4.02% 34.8 0.996 260 

1 

200 

39 281 76.8% 3 0.662 25.46 

2 119 281 59.1% 4.8 0.817 31.32 

3 199 281 24.00% 9.6 0.938 52.43 

4 279 279 11.30% 18.9 0.957 100.3 

5 360 354 4.93% 34.3 0.987 174.1 
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Gear Input 
voltage 

(Vrms) 

Motor 

speed 

 (rpm) 

PFC DC target 

(V) 

iTHD(%) Input 

power 

(W) 

Power factor Input 
current 

(mA) 

1 

250 

39 354 75.9% 4.1 0.643 28.59 

2 119 352 70.4% 5.9 0.748 33.86 

3 199 350 35.00% 10.8 0.913 48.31 

4 279 349 17.40% 19.4 0.956 83.2 

5 360 354 8.06% 33.1 0.968 137.7 

1 

300 

39 PFC stopped, 

Bus=419 

139.0% 5.3 0.409 45.5 

2 119 PFC stopped, 

Bus=417 

151.0% 6.9 0.436 54.91 

3 199 PFC stopped, 
Bus=416 

162.0% 11.8 0.479 84.5 

4 279 PFC stopped, 

Bus=413 

159.0% 21 0.511 134 

5 360 PFC stopped, 

Bus=408 

154.0% 34.4 0.528 241.7 
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5 References and appendices 

5.1 Abbreviations and definitions 

Table 24 Abbreviations 

Abbreviation Meaning 

CE Conformité Européenne 

EMI Electromagnetic interference 

UL Underwriters Laboratories 

RC-D2 Reverse-conducting drive 2 

5.2 References 

[1] Infineon Technologies AG. Datasheet of IKN03N60RC2 (2021) V1.0 www.infineon.com  

[2] Infineon Technologies AG. Datasheet of IMD112T-6F040 (2020) V1.0 www.infineon.com  

[3] Infineon Technologies AG. Datasheet of 1ED44171N01B (2021) V1.0 www.infineon.com  

[4] Infineon Technologies AG. MCEWizard_V2.3 User Guide (2019) www.infineon.com  

[5] Infineon Technologies AG. MCEDesigner_V2.3 Application Guide (2019) www.infineon.com  

[6] Infineon Technologies AG. iMOTIONTM Motion Control Engine Software Reference Manual (2021) V1.34 
www.infineon.com  

5.3 Additional information 

In order to initiate testing, customers are advised to order the iMOTIONTM link; detailed information is listed in 
Table 25.  

The Infineon components on the board are listed in Table 25 as well. The customers can visit the corresponding 

webpage for more information. 

Table 25 Additional information on tools and Infineon components  

 

 

  

Base part number Package Standard pack Orderable part number 

Form Quantity 

iMOTIONTM link  Container 1 IMOTIONLINK 

IMD112T-6F040 PG-LQFP-40 Tape and reel 1500 IMD112T6F040XUMA1 

IKD04N60RC2 PG-TO252-3 Tape and reel 2500 IKD04N60RC2ATMA1 

IKN03N60RC2 PG-SOT223-3 Tape and reel 2500 IKN03N60RC2ATMA1 

IED44171N01B PG-SOT23-5-1 Tape and reel 3000 1ED44171N01BXTSA1 

IKA08N65H5 PG-TO220-3 Tube 500 IKA08N65H5XKSA1 

XMC1100-Q024F0064 AB PG-VQFN-24 Tape and reel 6000 XMC1100Q024F0064ABXUMA1 

http://www.infineon.com/
http://www.infineon.com/
http://www.infineon.com/
http://www.infineon.com/
http://www.infineon.com/
http://www.infineon.com/
https://www.infineon.com/cms/en/product/evaluation-boards/imotion-link/
https://www.infineon.com/cms/en/product/power/motor-control-ics/digital-motor-controller-imotion/imd112t-6f040/
https://www.infineon.com/cms/en/product/power/igbt/igbt-discretes/ikd04n60rc2/
https://www.infineon.com/cms/en/product/packages/PG-SOT223/PG-SOT223-3-1/
https://www.infineon.com/cms/en/product/power/igbt/igbt-discretes/ikn03n60rc2/
https://www.infineon.com/cms/en/product/power/gate-driver-ics/1ed44171n01b/
https://www.infineon.com/cms/en/product/power/igbt/igbt-discretes/ika08n65h5/
https://www.infineon.com/cms/en/product/microcontroller/32-bit-industrial-microcontroller-based-on-arm-cortex-m/32-bit-xmc1000-industrial-microcontroller-arm-cortex-m0/xmc1100-q024f0064-ab/
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Revision history 
 

Document 

version 
Date of release Description of changes 

V 1.0 10/29/2021 Initial version. 

V 2.0 1/18/2022 Revised the software preparation and commissioning from Section 

2.1.2 to Section 2.1.8. 

V3.0 5/11/2022 Changed the PFC gate driver from IRS44273L to 1ED44171N01B. 

1) Changed the description of IRS44273L to IED44171N01B; 

2) Updated the picture in Figure 3; 

3) Updated the pictures in Figure37, Figure38, Figure39, Figure40; 

4) Updated the component information in Table 25. 
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